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OBJECTIVES

Objectives
Perhaps you have just downloaded the trial version of ATLAS.ti 8 because you are
generally curious about its possibilities. Or you are evaluating different software
packages for qualitative data analysis. Or maybe you just purchased ATLAS.ti and are
now eager to take your very first steps with the program.
The ATLAS.ti 8 Quick Tour was designed with users like yourself in mind!
Its main objectives are to provide an initial orientation for working with our software,
quickly acquaint you with its most important features, and demonstrate some of its
typical applications.
The tour first introduces some basic concepts that are important to know when working
with ATLAS.ti. The step-by-step instruction that follows uses a sample project, which can
be downloaded from our website. After learning about the main components of the
ATLAS.ti user interface, you are guided through the various phases of the analysis
process like creating a project, exploring the data, coding, working with comments and
memos, querying data, creating networks and reports. You will also get to know some
special options such as how to prepare and import survey data, how to import reference
manager and Twitter data.

Other Useful Resources For Getting Started
•
•
•
•

System requirements and installation instructions can be found here.
Download Whats' New in ATLAS.ti 8 Windows here.
Video tutorials in English and Spanish can be found on our YouTube channel.
Free introductory online webinars here.
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Basic Concepts

ATLAS.ti – The Knowledge Workbench
The image of our software as a "knowledge workbench" is more than just a lively analogy.
Analytical work involves tangible elements: research material requires piecework,
assembly, reworking, complex layouts, and some special "tooling". A well-stocked
workbench provides you with the necessary instruments to thoroughly analyze and
evaluate, search and query your data, to capture, visualize and share your findings.

Software For Creative Analysis
Your typical project deals with sifting through large sets of diverse documents, notes,
and multi-media files, and examining and comparing such sources regarding a specific
line of inquiry.
While the technical side of selecting, and organizing useful portions of your data might
seem manageable when dealing with just a handful of source documents, it can tend to
become overwhelming as the number of sources mount.
Enter a specialized software package like ATLAS.ti: It lets you extract, categorize, and
interlink data segments from a large variety and volume of source documents. Based on
your analysis, the software supports you in discovering patterns and testing hypotheses.
With numerous output options and collaboration tools, your analysis is easily accessible
to yourself and others.

Some Basic Terms And Concepts
To understand how ATLAS.ti handles data, visualize your entire project as an intelligent
"container" that keeps track of all your data. This container is your ATLAS.ti project.
The project keeps track of the paths to your source data and stores the codes, code
groups, network views, etc. that you develop during your work. Your source data files are
copied and stored in a repository. The standard option is for ATLAS.ti to manage the
documents for you in its internal database. If you work with larger audio or video files,
they can be linked "externally" to your project to preserve disk space. All files that you
assign to the project (except those externally linked) are copied, i.e. a duplicate is made
for ATLAS.ti's use. Your original files remain intact and untouched in their original
location.
Your source data can consist of text documents (such as interviews, articles, reports);
images (photos, screen shots, diagrams), audio recordings (interviews, broadcasts,
music), video clips (audiovisual material), PDF files (papers, brochures, reports), and
even geo data (locative data using Open Street Map).
Once your various documents are added or linked to an ATLAS.ti project, your real work
can begin. Most commonly, early project stages involve coding different data sources.
Coding is the basic activity you engage in when using ATLAS.ti and is the basis of
everything else you will do. In practical terms, coding refers to the process of assigning
categories, concepts, or "codes" to segments of information that are of interest to your
research objectives. We have modeled this function to correspond with the time-honored
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practice of marking (underlining or highlighting) and annotating text passages in a book
or other documents.
In its central conceptual underpinnings, ATLAS.ti has drawn deliberately from what
might be called the "paper and pencil paradigm." The user interface is designed
accordingly, and many of its processes are based on—and thus can be better understood
by—this analogy.
Because of this highly intuitive design principle, you will quickly come to appreciate the
margin area as one of your most central and preferred work space—even though
ATLAS.ti almost always offers a variety of ways to accomplish any given task.
***
Equipped with this basic understanding, you are now definitely ready to get your feet wet
and get acquainted with ATLAS.ti 8.
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First Steps
To familiarize with ATLAS.ti 8 quickly, you will be working with a sample project that we
have already created for you to experiment with.
The sample project (in two parts) is available online for download from
http://atlasti.com/manuals-docs/#Sample-Projects

The Sample Project
When searching for suitable example data for this Quick Tour, we happened upon an
article on the topic of children and happiness, written by Nattavudh Powdthavee in the
journal The Psychologist1. Nattavudh reports on several academic studies that repeatedly
found a negative correlation between having children and the parents' levels of
happiness, life satisfaction, marital satisfaction and mental well-being. These are on the
one hand provocative findings if you are a parent yourself; on the other hand, they add
fuel to the fire for people who have decided purposefully against parenthood ("I knew it
all along.").
In any case, no matter on which side of the issue you stand, the article and the various
reactions to it (in the form of blog discussions) promised to be interesting material for a
sample study. It will let you code the various blog posts and offers a variety of
opportunities to try out many of the powerful analytic functions ATLAS.ti brings to the
task.

Content
In addition to the journal article itself, a report written about this article in a parenting
blog and reader comments are included, as well as the reader comments of an article
published in the New York Times Magazine, and a summary of research finding regarding
happiness research more generally. Furthermore, some fictional survey data are available.
The survey data contains answers from 24 respondents to two open-ended questions:
Reasons for having and for not having children. You will import the survey data yourself
as part of the Quick Tour. The data is available for download here.

Starting ATLAS.ti
In Windows 10, start ATLAS.ti by typing ATLAS.ti 8.0 into the search field “Ask me
something” or ask the voice assistant Cortana to open it for you.
In older Windows versions, go to START / PROGRAMS and select SCIENTIFIC SOFTWARE /
ATLAS. TI 8. Or double-click the ATLAS.ti shortcut on your desktop if you selected this
option during installation.

1

Powdthavee, N. (2009). Think having children will make you happy? Think again, suggests Nattavudh
Powdthavee – you’re experiencing a focusing illusion, V 22 (4), 308-311.
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Figure 1: ATLAS.ti Start Screen – Create a new project, or open an existing one.

Download the sample project Children and happiness sample (stage 2).
If the above link does not work for you, you also find the sample projects here:
http://atlasti.com/manuals-docs/#Sample-Projects
Select the option I MPORT PROJECT B UNDLE .
If a project is already loaded, you need to select File / New. This will also bring you to a
screen where you see the Import Project Bundle option.

Interface
When you open a project, you see the ribbon on top, the project navigator on the lefthand side and the ATLAS.ti logo in the middle of the working area. At the top of the
screen, you see the title bar where the name of the current project is displayed. It also
includes the Save, Undo and Redo functions on the left-hand side. Below the title you see
ribbon tabs.
Video Tutorial: ATLAS.ti 8 Windows - Interface Overview
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Figure 2: ATLAS.ti 8 Interface

You are probably familiar with ribbons from other contemporary Windows software that
you use. A ribbon is a graphical control element in the form of a set of toolbars placed on
several tabs. They are grouped by functionality rather than object types, as was the case
in older versions of ATLAS.ti. Ribbons, in comparison, use tabs to expose different sets of
controls, eliminating the need for numerous parallel toolbars. This highly improves the
workflow and makes it easier for users to see which functions are available for a given
context.

The ATLAS.ti Ribbon
The five core tabs in ATLAS.ti are:

Figure 3: Core tabs in ATLAS.ti 8 to access the various functions

•
•
•
•
•

Home
Search Project
Analyze
Import / Export
Support

Depending on the function you are using, additional contextual tabs will appear. These
will be highlighted by a colored line at the top of the ribbon.
The H OME tab is the starting point for most projects. You can start here to add
documents to a project, create new codes, memos and networks (N EW ENTITIES ), open
various navigators to be displayed in the navigation area on the left-hand side of the
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screen, write a comment for your project, open the various managers, and project
explorers, or auto code your project.

Figure 4: The Home tab

The SEARCH PROJECT tab allows to search through all entities of your project. Later in this
tour there will be an exercise where you practice its functionality.

Figure 5: Search Project tab

The ANALYZE tab offers a number of advanced functions to analyze your data after
coding. See “Querying Data“ on page 49ff.

Figure 6: Analyze tab

Use the I MPORT/EXPORT tab to import Twitter data (page 79), to add data stored in
Evernote, to import data from Endnote or other reference managers to support the
analysis of literature (page 76), or to import survey data, especially responses to openended questions (page 72). If you are interested in a mixed-method approach, you can
generate a SPSS syntax file for further quantitative analysis in SPSS of your qualitative
coding.

Figure 7: Import/Export

If you want to report a problem, send suggestions, create or manage user accounts, want
to access the Quick Tour again or other resources, click on the SUPPORT tab.
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Figure 8: Support

Backdrop
Under FILE you find all options that concern your project, like creating a new project, open
existing projects, saving and deleting projects, exporting and merging projects.
In ATLAS.ti 8, projects are saved internally within the software environment. When
creating a new project, you enter a project name. There is no need to select a location
where to store your project.
If you want to create a copy of the project under a new name, select the SAVE A S option.
If you want to create a back up, or want to use your project on a different computer or
share it with team members, select the EXPORT option.
Use MERGE to unify projects. This option is mostly used by teams to merge projects from
different team members, but can of course also be used in single user projects, if the
need arises to put two or more projects together to analyze all data together.

The Six Main Entity Types
The six main entity types in ATLAS.ti are: Documents, Quotations, Codes, Memos,
Networks, and Links. All entity types have their own manager, which can be opened from
the Home tab:
To open the Document Manager, click on the Documents button; to open the Quotation
Manager, click on the Quotations button; to open the Code Manager click on the Codes
button, and so on.

Figure 9: Application
commands

The managers open as floating windows, but all windows can be docked as well (see
arrow on the top right in Figure 11). Each manager contains a list of the entities it
manages and some detail information about them. At the bottom of the list, you find a
comment field in each manager and in some managers, also a preview field. E.g. in the
Document and Quotation Manager you can preview the content of either the selected
document or the selected quotation. In the Memo Manager, the memo content is shown
next to the comment field.

Figure 10: The managers for the six main entities

Another common element is the navigator on the left-hand side, which can be used to
quickly access and filter the elements listed in the managers. On top of the navigator and
entity lists, you find a search field.
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Figure 11: Document Manager

In all managers but the Links Manager you find both a View and a Search tab. In the View
tab, you can activate or deactivate the navigator, the preview field (if available) or the
comments. The list of entities can either be displayed showing lots of detail or just as a
single column. In addition, you find a number of grouping options.

Figure 12: View

The search allows you to search through the entire content of documents, quotations or
memos, through entity names and comments, or entities created or written by a selected
author. The search term can contain regular expression (GREP; see full manual).
In case you wonder why there is a search option here in addition to the main Search tab,
the difference is that the search option in managers is restricted to the respective entity
type. Thus, if you are for instance in the Quotation Manager and you want to search
quotation content, accessing the search option directly in the manager is more
convenient.

Figure 13: Search
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Working With Docked And Floated Windows
When you first open a manager or other windows, they will be opened in floating mode.
All windows can however also be docked and depending on what you are currently doing,
you may prefer a window to be docked or floated. Once you have docked a window,
ATLAS.ti will remember this as your preferred setting for the current session. Let's
shortly practice how to dock and undock windows.
Open the Code Manager by clicking the Codes button on the Home Tab.

Figure 14: Floated Code Manager

To dock this window, click on the icon shown in Figure 14. To float the window again,
click on the drop down arrow as shown in Figure 16 and select FLOAT.

Figure 15: Docked Code Manager

Working With Tabs And Various Regions In The Main Work Space
In the next exercise, we would like to show you how to work with the various entities and
features in the main work space. While doing so, some other features are explained along
the way. Let's open some documents, the Code Manager and a memo:
To load a document, open the document tree in the navigation area on the left-hand
side and double-click document D1 and D3:
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Figure 16: Open documents from the navigation panel

The documents are loaded into two tabs in the main work space. The tab of the currently
loaded document is colored in yellow.

Figure 17: Documents loaded in tabs next to each other

If you want to see the documents side-by-side, you can move one of the documents
into a different tab group, cick on the down arrow and select NEW T AB G ROUP / RIGHT.

Figure 18: Moving a document into a new tab group

You have the option to move it into a tab group (or new region) to the right, left, below
or above. Move D3 into a tab group to the right.
By the way, this can also be done with any other items you open, be it your list of codes, a
memo, or a network. But we well get to this later. Let's look at the loaded document D3
with the margin area on the right-hand side.
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Display Of Coded Document With Margin Area
The margin area displays the coded segments that consist of a quotation and a linked
code. In the figure below one coded segment is selected and its quotation is highlighted
in context.

Figure 19: Coded document with margin area

Further, you see a memo that is linked to a quotation and a hyperlink. Hyperlinks are
quotation-quotation links, which we will look at more closely on page 27 : “Creating
Hyperlinks“.
Next, open the Code Manager: Click on the H OME main tab (1) and then on the button
CODES (2). The Code Manager opens in a floated window. Dock the window to the
currently active tab by clicking on the docking icon (3, top right of manager window, see
Figure 20).
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Figure 20: Exercise working with tabs, tab groups, docked and floating windows

Next, move D3 back to the left tab: Click on the down arrow of the D3 tab and select:
MOVE TO TAB GROUP / LEFT.
Next, we want to open a memo. Move the cursor to the navigation panel on the lefthand side of your screen and open the memo sub tree.

Figure 21: Memo sub tree in project explorer
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Load the first memo “**Types of memos” with a double-click into the main work
space. Depending on your setting, it either opens floated or in the first tab group. If it
opens floated, dock the window.
Now move it to the bottom of the page: Click on the down arrow and select N EW T AB
GROUP / B ELOW. Play around some more with opening items from the project explorer
and move them to new tabs or between tabs.

Figure 22: Individualize your work space so that it suits your needs
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Creating A New Project
In the following, it is shown how to create a new project and how to add documents. You
can use this project for the exercises on coding, on how to create groups and work with
comments and memos. For all subsequent exercises, we however recommend to work
with the provided sample project.
To create a new project, click on FILE to open the backdrop menu.
Select N EW. Click on the button: CREATE N EW PROJECT. Enter a project name like “My
first project” and click on CREATE.

Figure 23: Create a new project

V IDEO T UTORIAL: ATLAS. TI 8 W INDOWS C REATING A N EW PROJECT

Adding Documents
To add documents, click on the ADD D OCUMENTS button in the H OME tab, or click on the
dialog box launcher (drop-down arrow).
If you click on “Add Documents” you can select individual files. If you want to add entire
folders or link larger multimedia files (audio / video) to your project, click on the dialog
box launcher. All documents that you add to a project are copied and become internal
ATLAS.ti files.
Figure 24: Add documents to
a project

As audio and video files can be quite sizable, you have the option to link them instead.
This means they remain at their original location and are accessed from there. Preferably,
these files should not be moved to a different location. If the files need to be moved, you
need to re-link the files to your project. ATLAS.ti will alert you, if it can no longer access
the files.
All added documents are numbered consecutively starting with D1, D2, D3 and so on.
This Quick Tour focuses on working with text files. Shortly we will also make available
other sample projects that show you how to work with audio/video and geo
documents.
Video Tutorial: ATLAS.ti 8 Windows - Adding Documents to the Project
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Removing Documents From A Project
If you accidentally have added documents or want to remove them from your project
for other reasons, you can either right-click on a document in the navigator on the lefthand side and select the D ELETE option from the context , or open the Document
Manager (Documents button on the Home tab).
The later option is recommended if you want to remove multiple documents at once.
In the Document Manager, select the documents that you want to remove and click on
the DELETE D OCUMENT(S) button. You will not be asked for confirmation.
If you delete a document by mistake, you can always use the UNDO option in the Quick
Access tool bar.
Figure 25: Deleting project documents

Figure 27: Deleting multiple documents in the Document Manager

After deleting documents, the consecutive numbering may be off.
To renumber documents in consecutive order again, select the U TILITIES tab in the
Document Manager and the R ENUMBER D OCUMENTS option.
Figure 26: Renumber Documents

Saving Projects
To save a project, click on the Save icon in the Quick Access tool bar (see left), or select
FILE / SAVE.
Figure 28: Quick access tool bar

The project is saved as internal ATLAS.ti file in the Windows application folder called
AppData roaming on your computer. For further information, see 'Document Storage
And Project Back-Up for ATLAS.ti 8 Windows' on our website.

Creating A Copy Of The Project
The SAVE A S option under the FILE menu creates a copy of your project.
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Figure 29: Use the Save As option to create a copy of your project

After entering a new name, the new project can be opened immediately .If so, leave the
box 'Open the new project ' checked (see Figure 29). Or you can just create a copy and
continue to work with the current project. If so, uncheck the box.

Project Backup And Transfer
To create a backup of your project or a version that you can transfer to a different
computer, select FILE / E XPORT.

Figure 30: Project export

Click on the PROJECT B UNDLE button. This opens the Windows File Manager. Select a
location for storing the project bundle file.
The default name of the bundle is the project name. You can rename the bundle file
at this stage. However, please note – renaming the bundle does not automatically
change the name of your project. Think of the project bundle file like a box that
contains your project. Putting a different label on the outside of the box does not
change anything that is inside, which is your project with all your coded segments,
comments, memos, networks, etc. and all of the documents that have been added to
it.
The project bundle file can be used as project backup and to transfer your project to a
different computer. It can be read by both ATLAS.ti 8 Windows and ATLAS.ti Mac 1.5
and later.
Video Tutorials:
- ATLAS.ti 8 Windows - Exporting the Project
- ATLAS.ti 8 Windows - Transfer from ATLAS.ti 7 to ATLAS.ti 8
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Starting Data Analysis
We recommend that for the following exercises you work with the sample project:
Children & Happiness sample (stage 1). It contains 1 PDF document, 4 Word documents
and 2 images. It can be downloaded here. Or visit our website: sample projects.

Organizing Project Data
Often data come from different sources, locations, respondents with various
demographic backgrounds etc. To facilitate the handling of the different types of data,
they can be organized into document groups. Document groups allow quick access to
subsets of your data. They can be used for analytic comparisons in later stages of the
analysis, or for administrative purposes in team projects by for instance creating a group
that contains all documents for coder 1, another group that contains the documents for
coder 2 and so on.
Depending on your data, you may want to include a comparison of different groups based
on categories such as gender, profession, age, income, location, as well as data types and
sources. In ATLAS.ti a single document can be a member of multiple groups. For
instance: "Gender:: female" / "Profession:: teacher" / "Age group:: 31 - 40", and so on.
When querying data, you can combine the various groups as needed.
Groups can be created in two ways – you can create them in the side panel of the
Document Manager, or in the Document Group Manager. Both options are explained
below.
Video Tutorial: ATLAS.ti 8 Windows - Grouping the Project Documents

Creating Document Groups In The Document Manager
Open the Document Manager with a click on the D OCUMENTS button in the H OME tab.

Hold down the Ctrl-key to select documents D1 and D5, then drag-and-drop the
selected documents into the side panel on the left."

Figure 31: Creating document groups in the Document Manager

As name of the document group enter “Academic articles” and click CREATE or ENTER.
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Next create a group for D2, D3, and D4 and call it “blog data”. And a third group
“images” for D6 and D7.
As mentioned above, the document groups can be used to easily access sub sets of your
data. Click for instance on the group “blog data”. This filters the list of all documents and
the only ones that remain in the list are the documents from the selected group:

Figure 32: Filtering by document group

Once a group has been set as filter, a yellow bar appears above the list of documents. To
reset the filter to see all documents again, click the X on the right-hand side of the yellow
bar.

Creating Groups In The Group Manager
To open the Document Group Manager, select the HOME tab. Click on the drop-down
for documents and select D OCUMENT G ROUPS.
In the Group Manager, select the button New Group and enter a name.
Next select documents on the right-hand side in the pane: 'documents not in group'
and move them to the left-hand side 'documents in group'. You can either double-click
each document that you want to move, or you highlight multiple documents and click
on the button with the left arrow (<) to move them.

Figure 33: Adding members to a document group

Removing Group Members
Removing members works the opposite way as shown above: Select a document group.
In the pane 'Documents in group' select those documents that should be removed from
the group and click on the button with the right arrow (>).

ATLAS.ti 8 Windows – Quick Tour

23

STARTING DATA ANALYSIS

Deleting A Group
Select a group in the group manager and click on the Delete button in the ribbon.

Exploring The Content Of Text Documents
Creating Word Clouds And Word Lists
A quick way to get a feeling for the content of a text document is by creating a word
cloud or list.
To create a word cloud or list for just one document, right-click on a text document in
the navigation panel and select the option WORD CLOUD / W ORD L IST.

Figure 34: Word Cloud for one document

The Word Cloud tool bar provides several options like spiral or typewriter view, various
sorting option when in typewriter view, and a slider for limiting the number of words that
are shown by frequency of occurrence.

Figure 35: Word Cloud options

You can set the threshold to see every word that occurs at least 1 time, or higher to for
instance only show words that occur at least 5 or 10 times. In addition, you can apply a
number of filters. See the full manual for a more detailed description.
Video Tutorial: ATLAS.ti 8 Windows - Word Clouds
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To create a word cloud or word list of multiple documents, open the Document
Manager with a click on the DOCUMENTS button in the H OME tab.
Select one or more documents – document groups as filters come in handy here as well
– and select the Word Cloud or Frequencies option in the ribbon.

Figure 36: Creating a word cloud or list based on multiple documents

When selecting the option 'Frequencies', you can select to create an internal report using
the Build-in Tool, or to export the word list to Excel. The Excel export option allows you to
make further selections like getting a count per document, and total and relative counts
(see Figure 37).

Figure 37: Word List options when exporting to Excel

Reading Data, Noticing And Marking Interesting Things
Based on the word cloud, you get a first impression of what words have been used by
your respondents or by the writer of a report. However, in most cases this does not
replace a more detailed reading of the text. Meaning is often hidden between the lines.
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Thus, a next step is to become more familiar with your data. If you have been transcribing
audio recordings yourself, you are probably already quite familiar with the text and might
be able to begin with coding the data right away. We would like to invite you to follow
the next exercise nonetheless, as it will introduce an important feature of ATLAS.ti – the
quotation level.
Creating Quotations
The quotation level in ATLAS.ti is a unique feature, which not only facilitates interpretive
approaches much better than other programs, but also adds functionality that is
interesting for a broad range of analytical approaches like working with hyperlinks.
If not already open, please open the Children & Happiness (stage 1) sample project. The
focus of this exercise is on the technical aspects to show you the necessary mouse
clicks that you need to know.
D1 should still be open from the last exercise. If not, please open it, e.g. from the
navigator panel on the left.
Next, open the Quotation Manager (click on the H OME tab, click on the button
QUOTATIONS ). The Quotation Manager opens floating. Dock it and move it to a new tab
group to the right, so that you can see the document and the Quotation Manager sideby-side.
Click on the D1 document tab, so that it becomes the active tab. The ribbon on top
should automatically change and display the DOCUMENT . If not click on the Document
tab.
If you need more space on your screen, close the navigator on the left-hand side of
your screen.

Figure 38: Document and Quotation Manager loaded in two regions next to each other

Start reading the article and highlight a passage that you find interesting—just like
marking something with a highlighter when you read a journal article.
To make your "marking" permanent in ATLAS.ti, we need to create a quotation.
After highlighting something in the document, several buttons in the ribbon have
become active. Select the first option: CREATE FREE Q UOTATION .
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Figure 39: Create a new quotation without having to code immediately

You will now see a first entry in the Quotation Manager.
Click on it to preview the content of the quotation in the Preview area.
Next to this area, you see a comment field. Write some text into the comment field.

Figure 40: Quotation Manager with preview area and comment field

Please note on your screen, as soon as you work inside the Quotation Manager, the active
tab in the ribbon changes to QUOTATIONS . Among other options, you find an option to
rename quotations. By default, the quotation name consists of the first 60 characters of
textual quotations (document name for all other document types).
Notice, for instance, that the first sentence in the article can best be understood as a
hook. Rename the quotation by right-clicking and selecting the option RENAME. Change
the default name to “hook for article”. You can read the quotation in full length in the
preview field.
Add a few more quotations, write comments and rename the quotations so that the
new name reflects a summary of the content (cf. Figure 41).
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Figure 41: Renaming quotations to summarize the content, add first interpretations into comments

Each quotation has an ID which consists of the document number and a number that
indicates the chronological order when a quotation was created. Thus, quotation 1:4 was
created after quotation 1:3, and quotation 1:3 after quotation 1:2 and so on. Further
towards the right, you find a column with the start and stop position for each quotation.
The density is still 0 for all quotations as 'Density” indicates the number of codes linked
to a quotation.
When the list of quotation gets longer and longer and you are looking for a particular
quotation—a fully coded project may have hundreds, if not thousands of quotations—you
can use the search field on top of the quotation list.
If you want to save screen space and you are not yet coding your data, you can hide the
Codes column in the Quotation Manager: Select VIEW and deactivate CODES.

Figure 42: Hiding column with codes in the Quotation Manager

Video Tutorial: ATLAS.ti 8 Windows - Creating Quotations

Creating Hyperlinks
A hyperlink is a named linked between two quotations. If, for instance, you notice that
one statement in a report or interview is explaining a previous statement in a bit more
detail, you can link the two using the relation “explains.” Or you may find a contradictory
or supporting statement. These are just a few of the default relations that come with the
software. If they do not fit what you want to express, you can create user-defined
relations in the Relation Manager (H OME tab / LINKS button / R ELATIONS from drop down
menu).
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Figure 43: Relation Manager for Hyperlinks

To create a hyperlink, you can simply drag and drop one quotation on top of another in
the Quotation Manager or in the margin area. Or you select a quotation and click on the
LINK SOURCE button in the , select another quotation and click on the LINK T ARGET
button. Figure 44 shows the drag & drop option.

Figure 44: Linking two quotations via drag & drop in the Quotation
Manager

Practice linking the quotations you already have created to each other by using drag &
drop, or the options in the context menu.
You will see some symbols being added to the Quotation Id:
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Figure 45: List of commented and hyperlinked quotations

Here is what they indicate:
Symbol

Explanation

~

Quotation has a comment

<

Quotation is source of a hyperlink

>

Quotation is target of a hyperlink

<>

Quotation is both start and target, thus at least two other quotations are linked

Now look at the margin area; there you also see the hyperlinks that you just have
created:

Figure 46: Display of quotation and hyperlinks in the margin area

Just one last exercise before we move onto coding:
Everything you do in ATLAS.ti can be visualized in networks. This applies to anything,
whether it is creating hyperlinks, coding data, linking memos, adding entities to a group,
etc.
Let us now see how the hyperlinks you have created look in a network:
Go back to the Quotation Manager. If you have a quotation that is source and target,
select this quotation (if not any other).
Now select the OPEN N ETWORK button in the Quotation . Your network might look
similar to the one shown in Figure 47.
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Figure 47: Network based on the created hyperlinks

Networks can also be created within the graphical interface and you have several further
options, some of which will be shown later, in the section on networks. At this point, we
would like to point out an additional benefit of the renaming options for quotations. As
the names are displayed in a network, it allows you to create meaningful and easy to
understand models of your data. 'The hook for the article' <expands> 'guiding questions'
<continued by> 'worse than expectations....' and this is discussed by quotation [1:2]
'consistent evidence of negative correlation...'

Coding Data
In this section, we show you to code text and images. You can continue to work with the
currently open Children & Happiness (stage 1) project. Open document D3: Parenting
blog_reader comments. If the document is not on top, click on the Document tab.

Figure 48: Document offering all options that you need for coding

Creating And Applying Codes
Use your mouse to highlight the first sentence beginning with "I was happy before I
had kids...."
Next, click on the OPEN C ODING button in the Document ribbon. As name enter “same
level of happiness” and click CREATE C ODES. It is also possible to code a selection with
multiple codes. You can enter as many codes as apply (see Figure 42).
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Figure 49: Open Coding dialogue

An alternative is to right-click on the highlighted section and to chose ENTER C ODE N AMES
(see Figure 50).

Figure 50: Coding a text segment using the context menu

The coded segment is displayed in the margin area. A bar marks the size of the coded
segment (= quotation) and the code name appears next to it. When coding data in this
way, a new quotation is created automatically and the code is linked to this quotation.

Figure 51: Margin display of coded data segment

Next, highlight the remaining part of the paragraph starting at "However...," and
ending with "... irresponsibility." Here three issues can be coded. Click on the OPEN
CODING button again and enter three codes:
• parenting is hard work
• effects of parenting
• narcissistic culture
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When you are done entering code names, click on the CREATE C ODES button. The margin
area now looks like this:

Figure 52: Display of codes and quotations in the margin area

The work you have done so far also is visible in the Project Explorer on the left.
Take a look at your project explorer and open the sub trees for D3 and for codes:

Figure 53: Project Explorer after some codes have been created and linked

The number behind the quotations 3:1 and 3:2 indicate their start and stop position in the
document by number of characters. The number behind the codes (1-0) means that the
code has been applied 1 time (grounded = 1) and that it has not yet been linked to other
codes (density = 0). The density remains 0 until the researcher manually links codes to
other codes, mostly in later stages of the analysis if relationships between codes become
apparent. The density is not a value that is calculated by the software. It goes up, when
the researcher begins to link codes to each other (see “Working With Networks And
Links“ on page 62).
Video Tutorial: ATLAS.ti 8 Windows - Coding text documents
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Coding PDF Files
PDF files can be text or image files. Sometimes users accidentally add an image PDF and
wonder why they cannot select any text. If this happens but you want to be able to select
text, you need to re-create the PDF file, e.g. by letting an OCR scanner running over your
PDF image file. In a lot of PDF creators these days this is an option in the software, no
additional physical scan is needed.
A text PDF file can contain images and in ATLAS.ti you can select and code both text and
images within the same document and without having to change the coding mode.
If you want to code text, select the text just like you do in a Word file.
If you want to code an image within a PDF file, draw a rectangular area with your
mouse, just as if you would code an image (see “Coding An Image“ on page 39).
Document 1 is a PDF document. Try it out.
Video Tutorial: ATLAS.ti 8 Windows - Coding Audio and Video Documents

Applying Existing Codes
Now, we would like to invite you to continue for a few minutes to code the document. If
you come across a passage that you would like to code with an already existing code, you
can link one of the existing codes either via drag & drop from the project explorer, or you
open the Code Manager as shown before. Dock The Code Manager into a new tab group
to the right.
As shown in Figure 54 you can either drag & drop a code from the Explorer onto a
highlighted data segment, or from the Code Manager. The Code Manager also allows
you to drag & drop multiple codes.

Figure 54: Drag & Drop coding to apply existing codes

Another option is to use the LIST C ODING option. I
Click the List coding button. A window opens that shows all existing codes. Enter a
word or a few letters that occur somewhere in an already existing code. The list will be
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shortened and only shows the codes that contain the search term. Select one or more
codes from the list and click the OK button.

Figure 55: List Coding window: enter a search term to quickly find the code
you are looking for

Modifying The Length Of A Coded Segment
Modifying the length of a quotation is easy. Select the quotation by clicking on the
quotation bar or code in the margin area and move the “handle” in form of a little orange
circles to the right, to the left, or up or down, depending on whether you want to shorten
or lengthen the quotation:
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Figure 56: Modifying the length of a quotation

Replacing A Code
If you want to replace a code that is linked to a data segment, you can simply drag and
drop another code from either the Navigator or the Code Manager on top of it.

Changing And Removing Code Color
To change the code color, select one or multiple codes in the Code Manager and click on
the CHANGE C OLOR button in the Code tab. Select one of the offered colors.
Similar, when removing code color, select one or multiple codes in the Code Manager,
click on the CHANGE COLOR button in the Code tab and click on R EMOVE COLOR.
Code color can also be modified in a network.
Figure 57: Change code
color

Writing Code Comments
Code comments can be used for various types of purposes. The most common usage
probably is to use them for a code definition. If you work in teams, you may also want to
add a coding rule or an example quote. If you work inductively, you can use them to write
down first ideas of how you want to apply this code. You can also use it to write up
summaries of all segments coded with this code and your interpretation about it. There
are several ways to write a code comment.
If the Code Manager is open, you can use the comment field at the bottom of the
window.
In the margin area or the navigator, you can right-click on a code and select the EDIT
COMMENT option. The ribbons on top of the screen also contain a comment section.
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Figure 58: Places where you can access the code comment option

All codes that have a comment display a tilde (~) at the end of the code name and the
code icon shows a little yellow flag.

Merging Codes
You may begin your coding very close to the data generating lots of codes. In order not to
drown in a long list of codes, you need to aggregate those codes from time to time, which
means merging and renaming them to reflect the higher abstract level. Another reason
for merging is that you realize that two codes have the same meaning but you have used
two different labels.
For practicing this functionality, select two or more codes in your list and click on the
MERGE button.

Figure 59: Starting the code merge procedure

Next, select which code should be kept, in other words the target into which all other
codes should be merged, and click on the Merge Codes button.
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Figure 60: Merge Codes

If the codes to be merged already had a comment, these comments will be copied over
into the comment field of the target code.

Splitting A Code
Splitting a code is necessary if you have been lumping together many quotations under a
broad theme. This is a suitable approach for a first run through to get an idea about your
data. At some point, however, those codes need to be split up into smaller sub codes.
Think of a basket full of fruits. At first it is OK to collect all kinds of fruits, but then the
basket gets very full and you realize that it might be a good idea to use separate baskets
for citrus fruits, apples and bananas.
In the sample project, you find a code with the name: “effects pos: improved
relationships & position emotions." In the following we'll show how to split this
code into:
• effects pos: improved relationships
• effects pos: positive emotions
Select the code and click on the SPLIT C ODE button in the Code .
In the Split Code dialogue, you see a list of the quotations coded with the code and all
other related entities. In Figure 61 only the quotations are shown, all other options have
been deactivated on the left-hand side.
ATLAS.ti by default creates two sub codes, but you can add more when you click on the
New Code button. You can select to keep the original code including the quotations. This
would mean that a quotation is coded with both the sub code and the category code. Use
this option with care as it might clutter up your margin.
If you do not want to keep the original code, but have not assigned a sub code to each of
the quotations, you can select to “Keep Orphan Quotations”, so you do not lose them.
Orphan quotations are quotations that are not linked to any code.
In the column 'Codes' you can see whether a quotation has already been assigned to a
code or not (Figure 61).
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Figure 61: Split Code dialogue

Rename code 1 and 2, so one is called 'effects pos: improved relations' and the other
effects pos: positive emotions'.
To begin splitting, select one of the sub codes. For this exercise, let's use Code 1
Add all quotations that relate to “improved relationships”. Click on each quotation and
read it in the preview area. If it contains something about improved relationships with
either partners, own parents or the community, click on the ADD button to move it into
the sub code.
Repeat this for Code 2. Make sure that you deactivate Code 1 before adding
quotations. If aspects of both Code 1 and 2 are contained in a quotation, you can also
add two or more sub codes.
After sorting all quotations into their respective sub codes, click on the SPLIT CODE
button at the bottom left.
Take a look at the 'effects pos' code category in the Code Manager, or in the code list in
the Navigator, to see the result of the splitting process.

Figure 62: Result of code splitting
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Working With Code Groups
Code groups help in organizing codes, they make it easy to access specific codes from a
long list of codes, and they allow you to create any kind of filter you need to query your
data. As has been explained for document groups above, code groups can also be created
in two ways – you can create them in the Code Group Manager (click on the dialog box
launcher of the Code tab, see left), or in the side panel of the Code Manager. Below only
the later option is explained again. For the Group Manager option, revisit “Creating
Groups In The Group Manager“ on page 22.
To create a group in the Code Manager, click on the HOME tab and open the Code
Manager by clicking on the CODES button.
Select a few codes, e.g. the code “DEFINITION HAPPINESS” and all sub codes and drag
them into the navigator on the left-hand side.

Figure 63: Create code groups in the navigator

After dropping the codes, enter a name for the code group, e.g. 'definition happiness'
and click on the button CREATE.
If you click on the newly created code group, only the codes from this group will show
up in the list on the right-hand side. This allows you to quickly access codes in your list
without having to scroll the list all the time.
To show all codes again, close the yellow pane that shows up on top of the code list
when selecting a group.
If you are interested in learning about the differences between codes, code groups
and smart codes, please view this video.

Coding An Image
Load an image document (e.g. document 7: Don't worry be happy').
Select a rectangular area and click on the LIST CODING button in the ribbon to select
from the list of already existing codes.
Into the search field, enter source, so that the list only shows codes the contain the
word source. Select for instance 'source: appreciating the moment” and 'source:
children' as shown in Figure 64.
Video Tutorial: ATLAS.ti Windows 8-Coding Graphic Documents
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Figure 64: Code an image using the List Coding option

To modify an image quotation, just re-size the rectangle.

Retrieving Coded Data
There are several options to retrieve quotations. In the following you will learn how to
retrieve quotations of a single code. More complex retrievals are in the section “Querying
Data“. You can retrieve quotations of a single code in the Code Manager and in the
Quotation Manager. First let's explore the Code Manager option:
Open the Code Manager and dock it.
Next double-click a code. A list of quotations coded with the selected code opens. You
may need to re-position it so that it fits the windows on your screen, or dock it (see
below for further instructions).
Click on a quotation to view it in context.
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Figure 65: Quotation Retrieval in docked Code Manager showing a floated
quotation list

Figure 66: View retrieved quotation in context

Figure 67: Retrieving quotations via the docked quotation list

The list of retrieved quotations opens floated, but you can dock it. This makes
quotation retrieval more convenient. If you dock it, it shows up in the navigator on the
left-hand side. To dock the window, click on the down arrow at the top right (see
screenshot in the left in Figure 67).
The second option is to retrieve quotations in the Quotation Manager.
Open the Quotation Manager.
Select a code in the navigator. The list of quotations now only shows the quotations of
the selected code. If you click on a quotation, it will be shown in the preview area. If you
double-click, the quotation will be shown in the document context.
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Figure 68: Retrieving coded data in the Quotation Manager

The yellow bar on top shows the code you have selected. In technical terms, it functions
as a filter. This filter can be extended and you can formulate simple AND and OR queries:
AND: Show quotations where ALL the selected codes apply
OR: show all quotations linked to ANY of the selected codes
Figure 69 below shows an OR query for the two selected codes. With a click on the down
arrow next to any, you can change the operator to 'all'.

Figure 69: Simple AND and OR queries in the Quotation Manager
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ALL means that two or more codes have been applied to the exact same quotation. It
is a very restrictive operator. For other query option see “Querying Data“ below.
It is of course also possible to create a report of the retrieved quotations.
Click on the button R EPORT in the ribbon area of the Quotations (top right).
Select to include the Content and the Codes into the report. Deactivate any other
options. Click the REATE R EPORT. Find more detail in the section “Creating Reports“ on
page 69.

Figure 70: Creating a report for quotations
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Working With Comments And Memos
All entities in ATLAS.ti can be commented. In the exercises so far, you have learned
about quotation and code comments. In addition, you can also write comments for your
project, for each document, group, network, link and also for memos. The difference
between comments and memos is that:
Comments are always tied to an entity; they never stand alone. Memos, on the other
hand, are independent objects that can be linked to other objects or used as free, standalone memos. A further difference is that memo have their own name and type; they can
be grouped like documents and codes, and can be assigned as document for further
analysis.
The following two tables provides and an overview of most common usages of the
various comments and memos.
Comments for...

Typical Usage

the entire project

… contain a project description. Take for instance a look at the comment
written for this sample project by clicking on the EDIT COMMENT button in the
HOME tab.

documents

… provide meta information about the document, e.g., a source reference,
comments on an interview situation, etc. When you use ATLAS.ti for your
literature review, they may contain short summaries of the article or an
evaluation whether and how you want to continue to use this article.

groups

… describe the group / how you intend to use it / why you have grouped the
entities the way you did

quotations

… may contain an in interpretation of the data segment / may contain a
transcript of a video segment / may contain a summary of the data segment /
may contain a translation into another language, etc.

codes

… describe the code / provide coding rules / contain a sample quote /
summaries or interpretations of the coded content

memos

… may contain a note of another researcher on the team / supervisor reading
the memo / an evaluation where to use the memo in the ongoing analysis /
ideas for linking and building networks as comment on an analytical memo

networks

… describe the content of the network

links

… describe why the two entities (code-code relation or quotation-quotation
relation) are linked and why this relation has been used

Below there are only some ideas on how memos can be used. These are probably
sufficient to get your started. But do not feel restricted by the suggestions. In gaining
more experience in working with the software, you may come up with more ideas on how
to use memos.
Memos

Description

Type

Research diary

Summary of activities in a work session. Usually there is only method
one research diary per project. However, if your research
diary gets very long you may consider to split it up in multiple
memos, e.g. one per month

Research questions

List and descriptions of your research questions

memo

Notes for team
members

Things you notice during the analysis and that you want to
discuss with your team

for team

Ideas

As a place to collect ideas that arise during analysis

memo

On the code system

Notes on the code system like ideas on code refinement;
ideas for potential categories / higher order codes / sub

memo
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codes; notes to yourself where you still see areas of
improvement
To-do-memo

A general memo on things that are still on the to-do-list

memo

Interpretations /
answers to research
questions

Memos can be used as a place for writing-up analysis. Use a
analysis
quotation comment for interpretations on single data
segments and memos for interpretations across a larger range
of quotations, e.g. a retrieval by code or the results of more
complex retrievals in the query tool, the results of a codecooccurence or code-document table, etc.

When creating a report, comments can be included and you can select which types of
comments to include.

Creating Memos
Memos can be created from the HOME TAB, or in the Memo Manager.
To create a memo from the Home tab , open the drop-down menu of N EW ENTITIES and
select FREE MEMO .
Enter a name for the new memo and click CREATE.

Figure 71: Creating a new memo

Depending on your last settings, the memo editor may open as floating window or
docked. If you prefer a floating editor instead of the docked mode, you can change this.
ATLAS.ti will remember your preferred settings (see “Working With Docked and
Floated Windows“ on page 13).
The Memo Manager offers the following options:
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Figure 72: Memo Manager options

Open the Memo Manager by clicking on MEMOS in the H OME TAB and select the newly
created memo. The default type is memo. Let's change it to 'method'.
Click on the SET T YPE button and enter method as new type. Click on SET T YPE.

Figure 74: Create and set memo type

Figure 73: Set types in Memo
Manager

Double-check in the Type column of the Memo Manager whether the type has been
changed.

Linking Memos To Data Segments
Memos can be linked to quotations and codes. Take for instance a look at the memos
starting with RQ, which stands for 'research questions'. These are analytical memos and
the intent is to write up an answer to the research questions. When writing such memos,
you probably come across segments in your data (quotations) that nicely illustrate the
points you are making in the memo. In order not to lose these quotations, you can link
the memo to them. And this is how it works:
Drag and drop a memo from the Memo Manger or from the navigator onto a quotation
(the highlighted area), or the quotation bar in the margin area.
If you drop a memo onto code in the margin area, the code will be replaced!.
Try it out: Drag & drop the memo RQ2 onto two quotations and one code.
Figure 75 illustrates the various options. In the margin area, the memo link shows the
magenta colored memo icon.
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Figure 75: Linking memos to quotations and codes

Look a the groundedness and density count in either the navigator or Memo Manager.
Groundedness is 2 as you have linked the memo to two quotations; density is 5, as the
memo was previously already linked to five codes.
Which codes are linked to the memo can be seen in the navigator on the left (see Figure
75).

Viewing Memo Links In A Network
You can visualize the linkages by opening the memo in a network.
The easiest way to open a network for a memo is to right-click on a memo (no matter
where you are – you can select a memo in the margin area, the Memo Manager or the
navigator).
Select O PEN N ETWORK from the context menu.

Figure 76: Open a network on a memo (here a memo has been selected in the margin area)

To create the same view as shown in Figure 78, click on the Layout button and select
the option 'Orthogonal'.
Figure 77: Layout options

Play with a few of the other layout and rerouting options.
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Figure 78: Memo-Link Network
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Querying Data

Before you work through this and the network chapters, you may first want to gain
some practice with the basics of ATLAS.ti and continue the Quick Tour with the the
chapter “Working With Networks And Links“ on page 62.
For all exercises described in this chapter, please open the sample project Happiness &
children sample project (stage 2).
There are several ways to query data. You already learned the steps for a simple retrieval
based on one code, and based on multiple codes using the Boolean operators AND or OR
(see “Retrieving Coded Data“ on page 40). In the following, three further ways of
querying data are shown:
• Looking for code cooccurences. You might also think of it as a cross-tabulation of
codes.
• Looking for code frequencies (and content) across documents or document groups
• Looking for combinations of codes using Boolean, proximity or semantic operators in
the Query Tool
Look at the memo '5 Research Questions'; it contains five research questions RQ1 to RQ5.
In the following, we will show you how to query the data to find answers to RQ1, RQ3 and
RQ5. You can practice your skills further by trying to find answers to the remaining two
questions.

Code Cooccurrences Analysis - Example
RQ1: Do blog respondents who have children define happiness differently from those
without children? If they do, how do they differ?
In the example data set, cases are embedded within a document and coded with
attribute codes like #gender: female and '#fam status: has children' or '#fam status: no
children yet'. All attribute codes are marked with a hashtag. Within each case, other
issues are coded (see Figure 79). With the help of the Code Cooccurence tools one can
find out, what type of issues are mentioned for example by those who have children and
by those who do not have children:

Figure 79: Code-cooccurence in the margin

Research question 1 asks in particular for the differences in responses with regard to how
happiness has been defined by the respondents. Coded were the following three aspects:
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Figure 80: Category: DEFINITION HAPPINESS

Now, let's look at the attribute codes of the blog respondents:

Figure 81: Attribute codes

There are 20 respondents who do not have children, and 74 who have children.
Remember these data are social media data and we just collected what was out there.
When looking at frequency distributions in all subsequent analyses, we need to keep in
mind that the one group is much smaller than the other and that we need to account for
the different group sizes.

Running A Code-Cooccurence Query
Click on the core tab ANALYZE and select COOC T ABLE:

Figure 82: Opening the Code-Cooccurence Table

The following video tutorial explains the co-occurrence concept in ATLAS.ti and shows
how to examine them qualitatively and quantitatively.

Next you need to select the row and the column codes. For this exercise select the
'#fam: don't have children' and '#fam: have children' codes for the columns and all
definition happiness codes for the rows (Figure 83).
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Figure 83: Code-Coccurence Table

The first number in the cell is the total number of hits, how often the row and the column
code cooccur. The number in parenthesis is the c-coefficient. It is a number between 0
and 1, and the higher it is, the stronger is the relation between the two codes.
The c-coefficient is similar to a correlation coefficient. It can meaningfully be
interpreted, if your data set contains a higher number of cases, or if lots of instances
are coded. You can deactivate the c-coefficient by clicking on 'Show Coefficient' in the
ribbon. For further information see the full manual.
Double-click on a cell in the table to see the list of quotations coded with the two cooccuring codes. You can decide whether you want to review the quotations of the row
code or the quotations of the column code.
Double-click on a quotation to see it displayed in context.
To save the table in Excel format, click on the Export button in ribbon of the table.

Cross-Tabulation Of Codes By Documents & Groups
- Example
RQ2: Compare the comment written on the Parenting blog (D3: Reader comments) with
the comments written as response to the New York Times Magazine article (D4: NYTM
comments). More specifically let's compare their comments on positive and negative
effects of parenting.
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In order to compare single documents or groups of documents, click on the ANALYZE tab
and select CODES-D OCUMENT-T ABLE.

Figure 84: Opening the Code-Document-Table

In the CODES field, select all codes with the prefix 'effects neg' and all codes with the
prefix 'effects pos'. In order to see how many entries (= no. of respondents) there are in
the two documents, also select the code #blog entry. Next select the two documents
D3 and D4 for the columns.

Figure 85: Code-Document Table

The results show how often each selected codes has been applied in each document.
Notice that we have almost twice as many respondents(92) in D3: Reader comments
(parenting blog) as compared to D4: NYTM comments (47). This means for a proper
comparison, the table needs to be exported to Excel, where you can calculate relative
frequencies.

Figure 86: Export options

If you want to practice the Code-Document Table further, you can examine the
differences between D3 and D4 based on the code categories reasons for having
children (= sub codes of REASONS FOR HC)' and reasons for not having children (=sub
codes of REASONS FOR NHC)'. – The sample study also includes survey data where
respondents have provided reasons for and against having children. You find several
document groups for the survey respondents like gender or educational level. You see
them in the fourth field on the left in the Code-Document-Table. Check out whether
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they are differences between male and females or between different educational
levels regarding arguments put forward to have or not to have children.

Document And Group Comparisons In The Query
Tool
In addition to retrieving frequencies, if you are interested in comparing documents or
groups based on the content that you have been coding, you can use the Query Tool.
To open the Query Tool, select the ANALYZE tab and from there theQUERY T OOL .

Figure 87: Opening the Query Tool

In the following exercise, we will only query a single code in relation to either a document
or document group. Once you open the query tool, you will see that there are many more
options. For now, let's just get a feeling for the query tool. A more complex query is
introduced in the next section 'Complex Retrieval In The Query Tool'.
After starting the query tool, select the code group “definition happiness” with a
double-click.

Figure 88: Query Tool showing a simple retrieval of a code group
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This retrieval results in 20 quotations that you see at the bottom right in the blue status
line.
If you double-click on a quotation, you can see it in context. You find a report option at
the top right in the Query Tool tab (more on creating reports in the section “Creating
Reports“ on page 69).
With the Edit Scope option you can restrict the results of a query to a selected document
or document group.
To filter the result list by documents or document groups, click on the EDIT S COPE
button in the Query Tool ribbon.
After selecting the Edit Scope option, an additional region in a pale yellow color opens.
As scope select document D3 with a double-click. Notice that the results of your query
in the pane at the bottom right change. Also the information in the blue status bar
changes.

Figure 89: Setting a scope for a query

With the scope set to document D3, the number of resulting quotations is 11. In addition,
ATLAS.ti provides the total number of quotations of the term that you have set as scope
(here: the 315 quotations of document D3). The term can be as simple as just one
document or document group. You can however also build a more complex scope using
Boolean operators (AND, OR, ONE OF and NOT).
To change the scope, click on the D ELETE button. This resets the scope. Next select a
different document or document group.
When opening the Scope pane, the codes and code groups are hidden. Thus, before
setting a scope, you first need to define your query. Close the Scope pane, to modify
an existing query or to create a new one.
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Complex Retrieval In The Query Tool
Video Tutorial: ATLAS.ti 8 Windows - The Query Tool

Example
The query tool can also be used for more complex retrievals based on multiple codes.
Let's for instance examine the following research question:
RQ3: Do parents who report difficult aspects of parenting also talk about positive aspects?
Start with selecting the operator COOCCUR.
As we want all segments where parents write about negative effects of parenting,
select the '#fam: have children' code via a double-click to be entered in the node on
the left hand side.
On the right-hand side, you enter the code group 'effects of parenting negative'.

Figure 90: Building a more complex query

The resulting list of quotations is shown below the query. The query itself is interactive.
Click on the node '#fam: have children' and all quotations linked to this code will be
shown in the result pane.
Click on the node 'effecs of parenting negative' all quotations from this code group will
be listed.
Clicking on the node with the cooccurence operator, the results of the query will be
shown.
As we only want to find comments where parents both raise positive and negative issues
around parenting, we need to extend the query further.
Make sure that the cooccurence operator is the active element in the query. You will
see a blue frame around it. Now select the COOCCURENCE operator again and select
the code group 'effects of parenting positive' to complete the query.
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Figure 91: Extending the query

The resulting number of quotations for this query is 7. Thus, seven respondents have
written about both positive and negative effects of parenting. You can review the results
in context, or create a report if you prefer to read all quotations in an editor.
Another option is to store the query as a smart codefor further re-use:
Click on the SAVE S MART C ODE button in the QUERY T OOL tab.
As name enter: RQ3 (research question 3). You can now review all quotations of this
query at any time that is convenient, e.g. in the Code or Quotation Manager (Figure 92):
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Figure 92: Reviewing content of a smart code

Query Tool Operators Explained
Set operators allow combinations of keywords according to set operations. They are the
most common operators used in information retrieval systems.
Semantic operators exploit the network structures that were built from the codes.
Proximity operators are used to analyze the spatial relations (e. g., distance,
embeddedness, overlapping, co-occurrence) between coded data segments.

Set Operators
The following Set operators are available: OR, AND, ONE OF and NOT:

Figure 93: Available Set operators

OR, AND and ONE OF are binary operators which need exactly two operands as input. NOT
needs only one operand. However, the operands themselves may be of arbitrary
complexity. Codes, code groups, or other smart codes can be used as operands: "(A OR B)
AND (NOT C AND D)."
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ONE OF (Exactly one of the following is true): The ONE OF operator asks that
"EXACTLY one of…" the conditions must meet. It translates into everyday "either-or."
Example: "All quotations coded with EITHER 'Earth' OR 'Fire' (but not with both)."
AND (All of the following are true): The AND operator finds quotations that match ALL
the conditions specified in the query. This means you have applied two or more codes to
the same quotation. Example: "All quotations coded with 'Earth' AND 'Fire'." The AND
operator is very selective and often produces an empty result set. "Precision" of this
operator is high, but the "recall" is rather low. It produces best results when combined
with less restrictive operators or when the overall number of the available text segments
is large.
A or B

not (A or B)

A xor B
Q1

Q4

A

Q3

B

Q5

Q2

A and not B A and B not A and B

Figure 94: Boolean queries depicted
as Venn diagrams

OR (ANY of the following are true): The OR operator does not really match the
everyday usage of "OR." Its meaning is "At least one of…," including the case where ALL
conditions match. The OR operator retrieves all data segments (i. e., quotations) that are
coded with any of the codes used in the expression. Example: "All quotations coded with
'Earth' OR 'Fire'."
NOT (None of the following are true): The NOT operator tests for the absence of a
condition. Technically, it subtracts the findings of the non-negated term from all data
segments available. Given 120 quotations in the HU and 12 quotations assigned to code
"Fire," the query "NOT Fire" retrieves 108 quotations - those which are not coded with
"Fire." Of course, the operator can be used with an arbitrary expression as in the
argument "NOT (Earth OR Fire)" which is the equivalent of "neither Earth nor Fire."
The OR operator has the potential to generate a HUGE number of hits. It has high
"recall" (a lot is retrieved), but low "precision" (many of the retrieved quotations may
not necessarily fit).
Venn diagrams are descriptive schemes for illustrating the different set operations
associated with Set operators.

Semantic Operators
The operators in this section exploit connected codes resulting from previous theorybuilding work. While Boolean-based queries are extensional and simply enumerate the
elements of combined sets (e. g., Love OR Kindness), semantic operators are intentional,
as they already capture some meaning expressed in appropriately linked concepts (e. g.,
All Children of code (POSITIVE ATTITUDES)).
The UP operator (all parents of a code) looks at all directly linked codes and their
quotations at higher levels.
The DOWN operator (all children of a code) traverses the network from higher to lower
concepts, collecting all quotations from any of the sub codes. Only transitive code-code
relations are processed; all others are ignored.
When building a terminology from your codes, use the ISA relation for sub-term links.
Like the OR operator, the DOWN operator may produce large result sets. However,
because you make use of a theory, the "precision" is likely better as compared to using
OR.
The SIBLING operator finds all quotations that are connected to the selected code or any
other descendants of the same parent code. Example: "All quotations coded with Love or
any other Positive Attitude, here: kindness." See Figure 95.
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Figure 95: A hierarchy of concepts suitable for semantic
retrieval

With such a network of codes the following queries would make sense (Q1 to Q8 =
quotations):
All children of Code (Positive Attitude) => {Q1, Q2, Q3, Q4, Q5}
All children of Code (Negative Attitude} => {Q6, Q7, Q8}
All children of Code (Attitude) => {Q1, Q2, Q3, Q4, Q5, Q6, Q7, Q8}.

Proximity Operators
Proximity describes the spatial relation between quotations. Quotations can be
embedded in one another, one may follow another, etc. The operators in this section
exploit these relationships. They require two operands as their arguments. They differ
from the other operators in one important aspect: Proximity operators are noncommutative. This property makes their usage a little more difficult to learn.

Figure 96: Proximity operators

Non-commutativity requires a certain input sequence for the operands. While "A OR B" is
equal to "B OR A," this does not hold for any of the proximity operators: "A FOLLOWS B"
is not equal to "B FOLLOWS A." When building a query, always enter the expressions in
the order in which they appear in their natural language manifestation.
Another important characteristic for these operators is the specification of the operand
for which you want the quotations retrieved. "A WITHIN B" specifies the constraint, but
you must also specify if you want the quotations for the As or the Bs. This is done
implicitly by the sequence. The code (or term) that is entered first is the one in which you
are interested. If B’s quotations are requested, you have to enter "B ENCLOSES A" using
the query language described below.
Embedding Operators
The embedding operators describe quotations that are contained in one another and that
are coded with certain codes.
Quotations enclosing quotations: A ENCLOSES B retrieves all quotations coded with A
that contain quotations coded with B.
Quotations being enclosed by quotations: A being enclosed by B (WITHIN) retrieves all
quotations coded with A that are contained within data segments coded with B.
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Figure 97: Visualizing the spatial relations between segments

For example, if you want to retrieve all segments for "hard work but: fulfillment" related
to the code "#fam: have children", you would need to enter the query as follows (Figure
98):

Figure 98: An example WITHIN query

If you were to enter the query the other way around (i.e., the code 'fam: have children' on
the left hand side), the query tool would not deliver any results. If you are however
interested in reading all quotations coded with "#fam: have children" that contain
segments coded with 'hard work but: fulfillment', the query would need to look as
follows:

Figure 99: An example ENCLOSES query

From the above example we learn that you begin with the code whose content you are
most interested in and then think about the operator you need.
Overlap Operators
The overlap operators describe quotations that overlap one another:
Overlaps (quotation overlapping at start): A OVERLAPS B retrieves all quotations
coded with A that overlap quotations coded with B
Overlapped by (quotations overlapping at end): A OVERLAPPED BY B retrieves all
quotations coded with A that are overlapped by quotations coded with B.
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The Co-occurrence Operator
Often when interested in the relation between two or more codes, you don't really care
whether something overlaps or is overlapped by, or is within or encloses. It this is the
case, you simply use the Co-occurrs operator. Co-occur is essentially a short-cut for a
combination of the four proximity operators discussed above, plus the operator AND.
AND is a Set operator, but also finds cooccurrence, namely if coded segments overlap
100%.

Figure 100: Example of a cooccurence query

The query shown in Figure 100 retrieves all quotations that are coded with '#fam: 2 or
more children' that cooccur with quotations coded with codes in the code group 'effects
of parenting positive' in whatever way.
The more general cooccurrence operator is quite useful when working with transcripts. In
interviews, people often jump back and forth in time or between contexts, and therefore
it often does not make much sense to use the very specific embedding or to overlap
operators. With other types of data they are however quite useful. Think of video data
where it might be important whether action A was already going on before action B
started or vice versa. Or if you have coded longer sections in your data like biographical
time periods in a person's life and then did some more fine-grained coding within these
time periods. The WITHIN operator comes in very handy in such instances. The same
applies when working with pre-coded survey data. ATLAS.ti pre-codes your questions,
followed by manual or further selected auto coding. This enables you to ask for instance
for all quotations coded with "topic x" WITHIN "question 5."
Adjacency Operators
The distance operators describe a sequence of disjointed quotations.
Quotations following quotations: A FOLLOWS B retrieves all quotations coded with A
that follow quotations coded with B.
Quotations preceding quotations: A PRECEDES B retrieves all quotations coded with A
followed by quotations coded with B.
When selecting any of the two operators, you can specify a maximum distance (to be
implemented in version 8.1). Possible base units are characters and paragraphs for text,
milliseconds for audio files, frames for video data and pixels for images.
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Working With Networks And Links
Visualization can be a key element in discovering connections between concepts,
interpreting your findings, and effectively communicating your results. Network views in
ATLAS.ti allow you to accomplish all three of these important objectives. These small
segments of your larger web of analysis are modeled using the Network View Editor, an
intuitive work space that we also like to think is easy on the eye.

Exploring Network Views
The next exercise requires that we work with data in a later stage of analysis, i. e., a
project file that already contains some codes. Thus, we once again work with the stage 2
project (see our website, or download directly here).
Open the Networks tree in the Project Explorer. Select the first Network View in the list
"Children & Happiness" with a double-click.

Figure 101: Children & Happiness network

Network views contain a wide variety of features and options. Here is just a sampling to
get you started:
Depending on your screen size, enlarge or maximize the network view and adjust it to
the size of your window: Select the V IEW tab and then the button FIT TO W INDOW .
Move an object by selecting it and dragging it to different locations in the network
view.
Right-click on a code node or a link to view a series of options in the context menu.
Try out some of the provided options:
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Figure 102: Context menus in networks provide further options

Neighbors are all entities that are directly linked to the selected node. Co-occuring codes
are all codes that code data segments that overlap with segments coded with the
selected code (cf. Figure 97).
Video Tutorials:
- ATLAS.ti 8 Windows - Visualizing Linkages in Networks
- ATLAS.ti 8 Windows - Creating and Displaying Semantic Linkages
Next, we would like to invite you to experiment with the different layout and Routing
options that you find in the View tab of the network ribbon:

Figure 103: Network layout options

Following are just two examples:
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Figure 104: Network layout - example 1

Figure 105: Network layout - example 2

You may have noticed that the colors of two nodes have changed.
To change code colors on your screen, select a code; next select the NETWORK tab and
the COLOR button.
After you have experimented with some of these features, close the network.
Next, select the network 'Hyperlink-Web: Looking at sources of happiness'. It
contains image documents and a graphic quotation. If you select the PREVIEW option in
the STYLE group of the View tab (Figure 106), you will see previews of text and image
documents and of text and image quotations. Also try out the other options like
showing comments, virtual links or frequencies.
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Figure 106: Style Group in the View tab

Figure 107: Document and quotation reviews and display of virtual links

Creating Your Own Network View
There are several ways to create a new network view.
You can start by selecting a few codes in the Code Manager. Then click on the O PEN
N ETWORK button in the Codes ribbon.
Or: From on the Home tab, open on the drop-down menu of the NEW E NTITIES tab and
select N ETWORKS. Enter a name for your new network.
You can drag and drop entities from everywhere into the network editor.
Drag a few codes, one or two documents, some quotations and a memo from the
project explorer into the network editor.
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If you select items that already have been linked somewhere in your HU, the linkages
will show up immediately. The number of linkages for codes and memos are displayed
if you select the 'Show Frequencies” option in the View tab.
The network below contains three codes, one document and one memo. There is a virtual
link between the red and the green code to the D3 document as these two codes have
been applied in document 3.

Figure 108: Adding entities to a network

To link two codes to each other, select a code. A red dot appears on the top left corner
of the node. Click on the red dot with with the left mouse button and drag the mouse
pointer to the code that you want to link.
Release the left mouse button on top of the node. A list of relation opens consisting of
the default relations plus the relations of the currently open projects.

Figure 109: Linking codes to each other

Select one of these relations. Now the two codes are linked.
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Repeat this process and link other codes to each other.
If you link a memo to a code, or a code to a memo, there will not be a list of relations
to choose from. Specific relations with definable properties can be used for code-code
links and for quotation-quotation links.
Links between two quotations are called 'hyperlinks' in ATLAS.ti.
To add a few quotations to your network, you can either drag some from the Quotation
Manager into the network, or you can import quotation neighbors for one your codes.
To do this, right click on a code-node and select the option IMPORT NEIGHBORS / IMPORT
QUOTATION N EIGHBORS .
Please note that the import neighbor option potentially adds lots of entities to your
network. If you only want to keep a few of the imported quotations, highlight all
those that you do not want to keep, right click and select the option REMOVE FROM
V IEW.
With some quotations in your network, you can now also link two quotations to each
other.
Notice that the type of relations you can chose from is different form the list of codecode relations. When linking quotations to each other, you work on the data level. When
linking codes to each other, you work on the conceptual level. Therefore, ATLAS.ti offers
two distinct set of relations for these analytic activities.

Figure 110: Open
Relation Manager

Figure 111: A network showing a code-code link and a hyperlink

Creating And Modifying Relations
You can create any number of new relations and change the properties of existing
relations. This can be done in the Relation Manager.
To open the Relation Manager, select the H OME tab and from there the LINK button.
Open the drop-down menu and select R ELATIONS .
In the Relations tab, you can switch between editing Code-Code Relations or Hyperlink
Relations. You can define how a relation should look like in terms of color, width and line
style. Further you can select the layout direction and the formal property. The formal
property defines whether a relation is directed (transitive, asymmetric), or non-directed
(symmetric).
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Figure 112: Relation Manager (floating)

Select Code-Code Relations and then New Relation and go through the various steps
to define it.

If you are interested in learning more about network theory and how it is applied in
ATLAS.ti, you can watch the following video: Did you ever wonder what's behind the
ATLAS.ti network function.

Exporting Networks
Networks can be exported in various graphic file formats, in xps and PDF format and
inserted into other applications.
To save a network as graphic file, select the I MPORT/EXPORt tab and the EXPORT B ITMAP
option. When saving the file, you can chose among the following graphic file formats:
Figure 113: Options for
exporting networks

Figure 114: Different export formats for networks

To save a network in the Microsoft XPS format, select the EXPORT XPS option. The XPS
format is Microsoft’s alternative to PDF.
If you want to create a PDF file, make sure a PDF writer is installed on your computer. If
so, you can select the PRINT option and chose your PDF Writer as printer.
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Creating Reports
ATLAS.ti 8 in addition to providing predefined reports also offers user configurable
reports. This means you can decide what should be displayed in the report. Predefined
reports are available in the Query Tool under the Report button. If you hover over an
option with your mouse, the screen tip explains what each of the report contains:

Figure 115: You find these four predefined reports in the
query tool

Tables can be exported in Excel format, or text or graphic file. Take for example a look at
the E XPORT button of the Code-Document-Table in the Analyze tab. The graphic export
option converts the table to .png format.

Creating User-Configurable Reports
Open the Code Manager and select one or more codes. Click on the REPORT button in
the CODES tab.
The first option you may want to select is how the output is sorted. The default sort
order is by code. If you select multiple codes from different code groups, you can
choose to group the output by code groups. Or if work in a team, you may want to view
the quotations by creating or modifying user.

Figure 116: Select the sort order

The next step is to select all items that you want to include in the report:
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Figure 117: Code Report

Given the selections made in Figure 117, the output will contain the code name, the code
comment, all quotations linked to this code, their comments and content. If you do not
select the content option, only the quotation ID and and name are included in the report.
In the following a few more examples are provided.
If you for instance select 'Hyperlinks' under 'Quotations', a further sub-tree opens and
you have more options (Figure 118). If you only select Hyperlinks, the IDs and names of
hyperlinked quotations are listed. If you are interested in reading the content of the
hyperlinks and you want to know which codes have been applied to them, in addition you
would need to select 'Content' and 'Codes' in the Hyperlinks sub tree.

Figure 118: Further options

Video Tutorials:
- ATLAS.ti 8 Windows - Creating a Report of Coded Quotations
- ATLAS.ti 8 Windows - Creating an Output of Quotations Linked to a Code
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Creating A Code Book
To create a Code Book, you may want to select to group the output by code groups,
include the descriptions (= comment) of each code group, and the definitions for each
code (= code comment):

Figure 119: Possible settings for creating a code book

Video Tutorial: ATLAS.ti 8 Windows - Creating Output of Codes with Definitions
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Importing Survey Data
These days a lot of surveys are conducted online. A positive side effect is that (a) all data
is immediately available in digital format and (b) respondents often do write lengthy
answers to open ended questions. But even if you work with surveys from the "analog"
world, chances are, they will end up in an Excel™ spreadsheet at some point. Regardless
how your surveys originate, ATLAS.ti can handle them once they exist in that format. A
typical work flow for working with survey data looks like this:
Online surveys can be created using a number to tools. What most of these tools have in
common is that the let you export your data as Excel™ file. And this is what you need to
prepare for import in ATLAS.ti.
You can download an example Excel file here.
This video tutorial explains how to prepare and import surveys into ATLAS.ti. - Learn
more about how to work with survey data from this video.

Preparing Survey Data For Import
A survey broadly consists of the name of the survey, the questions, and the answers for
each respondent. Questions can be of different type:
• Single choice between two (yes/no) or more options
• Multiple choice
• Open ended
Within the framework of ATLAS.ti these concepts are mapped as follows:
Survey Concept

ATLAS.ti Concept

Open-ended question:
question
answer

Code (and code comment)
Content of a quotation

Single Choice 0/1

Document group

Single Choice > 2 options

Document groups from question plus value

Multiple Choice

Document groups from question plus value

Based on specific prefixes that you add to your variable names, ATLAS.ti interprets the
column headers and cells of the Excel™ table in different ways and turns them into
documents, the content of documents, document groups, quotations, codes, comments
and code groups. Sounds complicated, right? Not so –just follow along, it is actually very
easy!
Data are imported case-based. This means each row of the Excel™ table that is imported
from the online survey tool is transformed into a document.
In addition to the answers to open ended questions, demographic information like age,
profession, or age group, answers to single choice questions (yes/no, or offering more
than two options) and answers to multiple choice questions can be imported. Within the
framework of ATLAS.ti these are mapped in the form of document groups, one group per
value.
• ! the name in the cells is used as document name
• ^ name used in the author field per document
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• : a colon indicates to ATLAS.ti to turn the information in the cells into a group. As all
groups are dichotomous (0/1), a group is created for each value. For example, the
information written in the column :Gender is turned into two groups with the names:
Gender::male and Gender::female. The information in the column with the header :has
children is turn into the following to groups: has children::no and has children::yes. The
variable education is treated in the same way.
• . can be used for questions coded with 0 and 1. A document group is only created
from answers coded with 1. Thus, when importing the sample survey table, we get
one group that includes all respondents who have answered the question: "Do you
think that children bring happiness?" with yes, and one that includes all respondents
who have answered the question "Do you think children bring fulfillment and
purpose?" with yes.
All entries without a prefix notation are interpreted as codes and the text in the cells as
content for the case-based documents.
If the question is longer, and a short form not sufficient, then the full question content
can be added as code comment. For example, when using the column header 'Question 1::
Please write down reasons why you want to have children', Question 1 is used as code
name and the text after the two colons is used as code label:
You can import tables in xls or xlsx format. In case you experience a problem, save the
table in .csv format and try again.
If you import the same table repeatedly, rows with already existing documents are
ignored. This way, you do not have to wait until the last respondent has filled out the
questionnaire.
All prefixes are summarized in the following table:
Column Control via Field Name Prefixes
Prefix

Result

!

this column defines the document's name

~

this column defines the document's comment

^

this column defines the document's author

&

this column defines the document's date. Expects ISO8601 format

<

Ignore this column. Use this to exclude stuff inserted by the survey tool

.

Document group from the field name. Currently, the cell needs to contain1 or yes to
be applied.

:

Document groups from the field name plus the actual cell value

#

Document groups from field name plus values
Every column header that has no prefix is interpreted as code for an open-ended
question and the content of each cell in that column as data content that will be
added to the document for each case.

How To Import Survey Data
If you haven't done it yet, download the sample survey data here (or prepare your own).
Select the IMPORT/EXPORT tab and then the SURVEY button. Select the Excel file to be
imported and click Open. The import procedure starts. You see a progress report and
ATLAS.ti informs you when the import is finished.
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Inspecting Imported Survey Data
Open the Document Manager (Home tab / Documents button) and take a look at what
has been added to the project:

Figure 120: Document Manager after importing survey data

If you do not specify a name for each case, the default is case 1, case 2, case 3 and so on.
Here the name/synonym of each respondent was known and entered as author. Based on
the information provided in the Excel table, document groups were created. The
highlighted respondent 'case 6' for example has some college education, is a female,
single, and has no children. She answered the question: 'Do children bring happiness' with
yes.
ATLAS.ti automatically creates a group that contains all survey data in case you work
with data from multiple sources.
If your data comes in waves, you can add the data to the same data and import it
again. ATLAS.ti will only import the new information. This also applies if you add new
variables.
Each open-ended question was also automatically coded with the information provided
in Excel.
Double-click case 6 to open it and open the Code Manager alongside ( HOME tab / CODES
button).

ATLAS.ti 8 Windows – Quick Tour

75

IMPORTING SURVEY DATA

Figure 121: Coded document content after survey import

The first code has no a comment and the full length name is used as code label because
no syntax was added in the Excel.
SQ: Reasons for not having children
For the second open ended questions, the column in Excel was labeled:
SQ1:: Reasons for having children
Note the syntax that was used ::. The effect is that the text that follows the two colons
is entered as code definition in the code comment field. The code label is shorter and the
full label also does not appear in the body of the text, which can for instance effect word
clouds and word frequency counts in unwanted ways.

Working With Survey Data
Analyzing survey data requires that you know how to code (see Coding Data, on page 30).
You may want to explore the data first by creating Word Clouds, see page 23) and by
using the auto coding feature (not explained in this Quick Tour, you find the option under
the Home Tab / Auto Coding).
After coding, further analysis options that are often used with survey data are the CodeDocument Table, the Query Tool in combination with the Scope option and possibly also
the Code-Cooccurence Table. For further information, see the following sections:
Cross-Tabulation Of Codes By Documents & Groups - Example, pages 51ff
Document And Group Comparisons In The Query Tool, pages 53ff
Running A Code-Cooccurence Query, pages 50ff
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Working With Reference Manager Data
ATLAS.ti is frequently used for assisting with literature reviews. See for example:
• On Conducting a Literature Review with ATLAS.ti
• Literature Review using ATLAS.ti 7 - the Concept
• Managing Literature Reviews Using ATLAS.ti
ATLAS.ti 8 provides even better support for literature review as you can import your
articles directly from your favorite Reference Manager. The prerequisite is that you are
using Endnote, or a reference manager that allows you to create an export for Endnote in
XML format. This is for instance the case in following programs:
• Reference Manager
• Mendeley
• Zotero
You might collect a great many documents in your reference manager for a first
screening, or because you have come across an article that might potentially be of
interest at some point. You do not want to import all of these articles into ATLAS.ti, only
those that you want to look at more closely and that you have already identified as being
useful for your literature review and subsequent theory chapter. Therefore we
recommend that you prepare your data in the reference manager of your choice in such a
way that the export only contains a pre-selection of documents. How this is done is
different in each reference manager.
MENDELEY

In Mendeley, for instance, you highlight the documents that you want to export, rightclick and select E XPORT. When saving the file, you can select the file format:

Figure 122: Exporting an EndNote XML file in Mendeley

Select E NDNOTE XML as file type, and save the file.
ZOTERO

In Zotero, you find the export option under the FILE menu: EXPORT LIBRARY.
Zotero offers about ten different formats to export to. Here, too, select the Endnote
XML option.
In addition, you can export your notes and the full content of the documents. Select
both options. The notes will be imported as document comments in ATLAS.ti.
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Figure 123: Exporting an Endnote XML file in
Zotero

Importing Documents
To start importing the file into ATLAS.ti, select the I MPORT/EXPORT tab and the button
ENDNOTE .

Figure 124: Select import options

By default, ATLAS.ti creates document groups for authors, language, periodical name,
publisher and type of document (journal article, book, book chapter, etc.). Further
grouping options are:

Figure 125: Further grouping options

If you import documents from more than one reference manager, it is useful to group
documents by source, so that you know where they were coming from.
The default name for the document in ATLAS.ti is the name of the document as it used
in the Reference Manager.
For easier sorting and organization, you can chose to add the name of the first author
and the publishing year to the document name.
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Figure 126: Add 1st author and year to document name

If only the document abstract is available and not the full document, you can select to
import the abstract as a document:

Figure 127: Import abstract as document if the full content is not available

Make your selections and click the I MPORT button.

Inspecting Imported Documents
Open the Document Manager ((Home tab / Documents button):

Figure 128: Documents imported from Zotero

The imported documents are sorted by author and year in alphabetical order. Further,
document groups were created based on the available information. Document 4 for
instance was published in Nurse Researcher in 2002 and the source is Zotero. The text
entered as note in Zotero was imported as comment. If there are no notes for the
document, the URL of the document is added into the comment field (if available).
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Importing Twitter Data
This section shows you how to import Twitter data.
A sample project showing how to work with Twitter data will follow later.
To import Twitter data, select the IMPORT/EXPORT tab and then the T WITTER button.
Enter a query. You can also look for multiple hashtags or authors by using OR. For
example: #WorldAidsDay|#HIV|#Aids.

Figure 129: Set Twitter import options

Next, select whether you want to import the most recent or the most popular tweets
and whether to include re-tweets, images and profile images.
Note that you only will be able to import tweets from the last week. Further, as the
final selection is done by Twitter and not within our control, queries at different
times, or on different computers may result in different tweets.
The imported data is automatically coded based on the selection you make:

Figure 130: Select coding options
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Tweets often contain many more hashtags then the original one you searched for.
Coding all hashtags often results in a lot of codes. Therefore you have an option to
only code the queried hashtags. Further options are to code all authors and all
mentioned Twitter users, the location and the language.
Lastly you can decide whether a link should be created between authors and locations
and between the authors and mentioned Twitter users.

Figure 131: Select linking options

Inspecting Imported Twitter Data
Load the imported and automatically coded document, e.g. from the project explorer
on the left-hand side.
On the top of the document, you can read how many tweets and retweets were imported
and how many you requested. Each tweet is coded with the selection you have made.

Figure 132: Imported Twitter data

Open the Code Manager to inspect the code and code groups that have been created
(H OME tab / CODES button):
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Figure 133: Codes and code groups created during Twitter import

The code groups help you to navigate through your codes. By clicking on the code group
Twitter: Languages, for instance, you can immediately see how many and which
languages are used in the tweets you imported.
Video Tutorials:
- ATLAS.ti 8 Windows - Working with Twitter Data
- ATLAS.ti 8 Windows - Working with Geo Documents

...And That’s A Wrap!
Congratulations, you have now reached the end of the ATLAS.ti Quick Tour.
After working through this tour, you should now have a reasonable grasp of the central
concepts and functions of ATLAS.ti 8. You should be able to assess how powerful a tool it
is, and have a good idea how productively it can be put to use in your day-to-day work.
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